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Chapter 1. Overview of ASN1C for Go

The ASN1C codegenerationtool translatesan Abstract Syntax Notation 1 (ASN.1) or XML SchemaDefinitions (X SD)
source file into computer language source files that allow typed data to be encoded/decoded. This release of ASN1C
includes options to generate code in the following languages: C, C++, C#, Java, Python, or Go. This manual discusses
the Go code generation capabilities. The following manual's discuss the other language code generation capabilities:

ASN1C C/C++ Compiler User's Manual : C/C++ code generation

ASN1C C# Compiler User's Manual : C# code generation

» ASNI1C Java Compiler User's Manual : Java code generation

ASN1C Python Compiler User's Manual : Python code generation

Each ASN.1 module that is encountered in an ASN.1 schema source file results in the generation of a Go source file.
The name of the fileisthe ASN.1 module name, with hyphens removed and changed to camel-case, and an extension
of ".go".

Thereisalso aset of functions that form the run-time component of the Go package. These functions provide primitive
component building blocksthat are assembled by the compiler to encode/decode complex structures. They also provide
support for managing message buffers that hold the encoded message components.

Thisrelease of the ASN1C Compiler for Go workswiththeversion of ASN.1 specifiedin ITU-T international standards
X.680 through X.683. It generates code for encoding/decoding data in accordance with the following encoding rules:

* Packed Encoding Rules (PER) as published in the ITU-T X.691 and ISO/IEC 8825-2 standards. Includes both the
aligned and unaligned variants (note: the unaligned variant is commonly known as UPER).

» JSON Encoding Rules (JER) as published in the ITU-T X.697 and | SO/IEC 8825-8 standards.

ASNIC for Go is capable of parsing all ASN.1 syntax as defined in the standards. It is capable of parsing advanced
syntax including Information Object Specifications as defined in ITU-T X.681 as well as Parameterized Types as
defined in ITU-T X.683.




Chapter 2. ASN1C Command Line Interface

(CLI)

Running ASN1C

The ASN1C compiler distribution contains command-line compiler executables as well as a graphical user interface
(GUI) wizard that can aid in the specification of compiler options. Please refer to the ASN1C C/C++ Compiler User's
Manual for instructions on how to run the compiler. The remaining sections describe options and configuration items

specific to Go.

ASN1C Go Command Line Options

The following table shows a summary of the command line options that have meaning when generating Go code:

Option

Argument

Description

-config

<filename>

Thisoptionisusedto specify thename
of a file containing configuration in-
formation for the source file being
parsed. A full discussion of the con-
tents of a configuration file is provid-
ed inthe Compiler Configuration File
section.

-depends

None

Without this option, the compiler on-
ly generates Go code for the files that
were explicitly given asinput, and not
for any filesit may automatically load
on account of IMPORTS. This option
tellsthe compiler to also generate code
for filesit automatically loads, but on-
ly that code which is necessary to sat-
isfy dependencies that originate in the
main file set.

-genPrint
-print

None

Generate code to print object con-
tents. The open source go-spew pack-
age (https:.//github.com/davecgh/go-
spew) is used for this purpose.

None

Generate code to populate a PDU ob-
ject with random test data. This code
will be embedded in the body of agen-
erated main.go program.

<directory>

This option specifies a directory
where the compiler should search
for ASN.1 source files for IMPORT
items. Multiple - qualifiers can be
used to specify multiple directoriesto
search.

-json or -jer

None

This option is used to generate en-
code/decode functions that implement
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Option

Argument

Description

the Javascript Object Notation (JSON)
Encoding Rules (JER) as specified in
the X.697 ASN.1 standard.

None

Suppress generation of code to check
constraints.

-list

None

Generate listing. This will dump the
source ASN.1 to the standard output
deviceasit isparsed. This can be use-
ful for finding parse errors.

-nodecode

None

Suppress generation of decode func-
tions.

-noencode

None

Suppresses generation of encode func-
tions.

-noOpenExt

None

Suppress the generation of open ex-
tension elements in constructs that
contain extensibility markers. The
purpose of theelement isto collect any
unknown itemsin amessage. If an ap-
plication does not care about these un-
known items, it can use this option to
reduce the size of the generated code
and increase performance.

-noUniqueNames

None

Turn off the capability to automat-
icaly generate unique names to re-
solve name collisions in the generat-
ed code. Name collisions can occur,
for example, if two modules are be-
ing compiled that contain a produc-
tion with the same name. A unique
name is generated by prepending the
module name to one of the produc-
tions to form a name of the form
<module>_<name>.

Note that name collisions can aso be
manually resolved by using the type-
Prefix, enumPrefix, and valuePrefix
configuration items (see the Compil-
er Configuration File section for more
details).

-no-go-main

None

Suppress the generation of a main.go
file. By default, this file is generated
with options to encode (-writer) and
decode (-reader) a message of a PDU

type.

<directory>

Specify the name of a directory to
which all of the generated fileswill be
written.
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Option

Argument

Description

-pdu

<typeName>

Designate given type name to be a
Protocol Definition Unit (PDU) type.
By default, PDU types are determined
to be types that are not referenced by
any other types within amodule. This
option allowsthat behavior to be over-
ridden.

_pe"

None

This option is used to generate en-
code/decode functions that implement
the Packed Encoding Rules (PER -
aligned variant) as specified in the
ASN.1 standards.

-shortnames

None

Change the names generated by com-
piler for embedded typesin construct-
ed types.

-tables

None

Generate additional code for the han-
dling of table constraints as defined in
the X.682 standard.

-uper

None

This option is used to generate en-
code/decode functions that implement
the Packed Encoding Rules (PER -
unaligned variant) as specified in the
ASN.1 standards.

-warnings

None

Output information on compiler gen-
erated warnings.

Compiler Configuration File

In addition to command line options, a configuration file can be used to specify compiler options. These options can
be applied not only globally but also to specific modules and productions.

The basic structure of a configuration fileis described in the C/C++ User's Guide. Configuration itemsthat are applic-
able to Go code generation are described in the following sections.

Global Level

These attributes can be applied at the global level by including them within the <asnlconf i g> section:

Name

Values

Description

<includedir></includedir>

<Include directory>

This configuration

item is used to specify adirectory that

will be searched for IMPORT files. It is equivalent to the
-I command-line option.

Module Level

These attributes can be applied at the module level by including them within a <module> section:

Name

Values

Description

<name> </name>

module name

This attribute identifies the module to
which this section applies. Either this
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Name

Values

Description

or the <oid> element/attribute is re-
quired.

<oid>

module OID (object identifier)

Thisattribute providesfor an alternate
form of module identification for the
case when module nameis not unique.
For example, a given ASN.1 module
may have multiple versions. A unique
version of the module can be identi-
fied using the OID value.

<include
values="names'/>

types="names"

ASN.1 type or values names are spec-
ified as an attribute list

Thisitem allows alist of ASN.1 types
and/or values to be included in the
generated code. By default, the com-
piler generates code for al types and
values within a specification. This al-
lows the user to reduce the size of
the generated code by selecting only a
subset of the types/valuesin a specifi-
cation for compilation.

Notethat if atypeor valueisincluded
that has dependent types or values (for
example, the element types in a SE-
QUENCE, SET, or CHOICE), dl of
the dependent types will be automati-
cally included as well.

<exclude
vaues="names'/>

types="names’

ASN.1 type or values names are spec-
ified as an attribute list

Thisitem allowsalist of ASN.1 types
and/or values to be excluded from the
generated code. By default, the com-
piler generates code for al types and
values within a specification. This is
generally not as useful as the include
directive because most typesin aspec-
ification arereferenced by other types.
If an attempt is made to exclude atype
or value referenced by another item,
the directive will be ignored.

<sourceFile>
</sourceFile>

source file name

Indicates the given module is con-
tained within the given ASN.1 source
file. Thisis used on IMPORTs to in-
struct the compiler where to look for
imported definitions.

<valuePrefix> </valuePrefix>

prefix text

This is used to specify a prefix that
will be applied to all generated value
constantswithinamodule. Thiscanbe
used to prevent name clashes if mul-
tiple modules are involved that use a
common name for two or more differ-
ent value declarations.

Production Level
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These attributes can be applied at the production level by including them within a <production> section:

Name Values Description
<name> production name Thisattributeidentifiesthe production
</name> (type) to which this section applies.

The name may also be specified as an
attribute. In either case, it isrequired.

<typePrefix> </typePrefix> prefix text This is used to specify a prefix that
will be applied to generated Go type
namesfor this production. Thiscan be
used to prevent name clashes if multi-
plemodulesareinvolvedinacompila
tion and they contain common names.

Element Level

These attributes can be applied at the element level by including them within an <element> section:

Name Values Description
<name> element name This element identifies the ele
</name> ment within a SEQUENCE, SET, or

CHOICE construct to which this sec-
tion applies. It may also be specified
as an attribute. In either case, itisre-
quired.

<notUsed/> n‘a Thisflag variable specifiesthat thisel-
ement will not be used at al in the
generated code. It can only be ap-
plied to optional elements within a
SEQUENCE or SET, or to elements
within a CHOICE. Its purpose is for
production of more compact code by
allowing users to configure out items
that are of no interest to them.

Compiler Error Reporting

Errors that can occur when generating source code from ASN.1 take two forms; syntax errors and semantic errors.

Syntax errors are errors in the ASN.1 source specification itself. These occur when the rules specified in the ASN.1
grammar are not followed. ASN1C will flag these types of errors with the error message 'Syntax Error' and abort
compilation on the source file. The offending line number will be provided. The user can re-run the compilation with
the'-I' flag specified to see the lines listed as they are parsed. This can be quite helpful in tracking down a syntax error.

The most common types of syntax errors are as follows:
* Invalid case on identifiers: module names must begin with an uppercase | etter, production (type) names must begin
with an uppercase letter, and element names within constructors (SEQUENCE, SET, CHOICE) must begin with

lowercase |etters.

 Elements within constructors not properly delimited with commas: either a comma is omitted at the end of an
element declaration, or an extracommais added at the end of an element declaration before the closing brace.
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* Invalid special characters: only letters, numbers, and the hyphen (-) character are allowed. Programmers tend to
like to use the underscore character () inidentifiers. Thisis not allowed in ASN.1. Conversely, Go does not allow
hyphensin identifiers and prefers names bein camel-case form. ASN1C will attempt to transform the ASN.1 names
into the Go preferred format.

Semantic errors occur on the compiler back-end as the code is being generated. In this case, parsing was successful,
but the compiler does not know how to generate the code. These errors are flagged by embedding error messages
directly in the generated code.




Chapter 3. ASN1C GUI Users Guide
Quick Start

In this section, we will demonstrate running ACGUI, creating a new ASN.1 schema, and compiling it to C for BER
data. The processis similar for other languages.

First, start ACGUI. Y ou may see the window below asking you to activate alicense key.

d

License Type
® Key () File

License Key:

Activate Deactivate

License file not found.

If you are using a proxy server, enter it below (myproxyhost:8765):

HTTP_PROXY: |

Skip

If you see thiswindow, and it's not showing a current license key, you can right click in the text box and paste in your
license key. Then click the Activate button to unlock ASN1C.

In some cases, however, the window will appear and show a current license key. In these cases the key being shown
isprobably expired. Y ou need to deactivate the current key first by clicking the Deactivate button. Then you can right
click in the text box and paste in your current license key. Then click the Activate button to unlock ASN1C.

If you have an osydlic.txt license file in alocation where the GUI doesn't ook, you can click the Import button to find
that file and use it to unlock ASN1C instead of activating a key.

If you click the Skip button, you can expore the features of the GUI, but you will not be able to generate any code.
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Should you ever need to activate adifferent license key even though you have acurrent one (for example, you purchase
ASNI1C before your evaluation key expires), you should deactivate the existing license first. This deactivation can be
done from the GUI by choosing Tools...Options and then clicking on the License tab. Y ou will see awindow similar
to thisone:

License General
License Type
kKey File
License Key:
3T ALOjh AU +aQg8c 6mY BbuEQxrBxyAydBbMhSmia/
d5ERStenx 3GANsSMC 13MUPWNySBGOP iImPhax Skallidg==
Activate Deactivate
License expiration date: Tue Jan 30 14:37:39 2013
If you are using a proxy server, enter it below (myproxyhost:8765):
HTTP_PROXY:
Restore Defaults oK Cancel

Click the Deactivate button to deactivate the existing license. Y ou can then do the same sequence to bring up the
window again and activate your new key.

Once the program is running, we'll create a new project to store all of our settings. To do this, select "Project->New
Project..." from the menus.
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D ASN1C Settings ? X
Qutput Function Generation Constraints and Debugging Code Modifications
Application Language Type
® bone Oc¢ O c+ Ocz O Java O python O o
ASN, 1 Standard
(® ¥.680-X.683 - current in force ASN, 1 standards (O ¥, 208- previous now withdrawn standard
Additional Translations
[] cenerate HTML files for input ASN. 1 [ Generate equivalent XML schema [ pretty-print ASN. 1
Encoding Rules
BER CER DER. PER APER UPER ISON XER A R OER COER
Ou Browse
Browse
Input Options
[ Perform & lax syntax check [ Allow ambiguous tags
s

Inthefirst tab, "Output", under "Application Language Type", select "C". Below that, under "Encoding Rules", select
"BER". Finally, choose an output directory for the generated files. Once the settings are correct, click "Save". These
settings can be changed at any time by selecting " Project->Project Settings..." from the menus.

Next, we'll create anew schemafilefor our project. Click the"New" button inthetoolbar or select "File->New Schema
File" from the menus. A dialog box will be shown to provide a name for the new file. Once entered, the file will be
added to the project window under "Schema/ASN.1 files' and its empty contents will be shown in the editor.

10
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File Edit Project Tools Help

O » B v [ €« »

New Gpen Remove Savefile Vaiidate Compie Previous Error MextError

Project Bl testasn* £ | o o
Untitled || 4 yhiodule DEFINITIONS 5= BEGIN
2

4 Schema/ASN1 files
testasn® JEND
Include Directories
Configuration files

> Generated Items

Error Log g X

Clear Save Log

#  File Line Column Message

Now we need to write our schema between the "DEFINITIONS ::= BEGIN" and "END" statementsin the file. Enter
something like:

MySequence ::= SEQUENCE {
i ngredi ent PrintableString,
count | NTECER,
units PrintableString

When you are satisfied with the schema you've created, click the "Validate" button to make sure there are no errors.
Since the new schema file hasn't been saved yet, ACGUI will ask if it should be. Save the new file and ACGUI will
then validate it. If the schema has errors, the log at the bottom of the window will show them. Otherwise, it is safe
to move on.

Since we've already set up our project, we can click the "Compil€" button to generate code according to our project
settings. If al goes well, the project window will show alist of generated files under "Generated Items" in the section
for the selected language. If there were any errors, they will be shown in the log.

11
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File Edit Project Tools Help
L
0B x ) = C
%
New Open Remove Savefle Vaidate Compie PreviousErar NextEro
Project B[ test.asn 6 ‘ | s Tree & x
C/work/asnlc/testacpral || q hyhiodule DEFINITIONS := BEGIN
4 Schema/ASM1 files 2 4t MyModule
test.asn 3 MySequence -= SEQUENCE { 4 1 Types
Include Directories 4 ingredient PrintableString, 4 B MySequence
Configuration files 5 CUunIINTEGER . ® ingredient
4 Generated Items 8 units PrintableString & count
4 C/Ce files 71 * units
MyMadule.c 8
MyModuleh BEMND
MyModuleDec.c
MyModuleEnc.c
rtkey.h
C# files
Java files
KSD files
Text Browser
Error Log J X
# File Line Column Message
Q1 Parsing ASN.1 definitions..
3 2 MyModuleh Writing C type definitions to file MyModule.h.
@ 3 MyModuleEnc.c Writing C encode functions to file MyModuleEnc.c.
@ 4 MyModuleDec.c Writing C decode functions to file MyModuleDec.c.
3 5 MyModule Writing C global variables to file MyMedule.c.
Q6 Code was successfully generated in C:/work/asnlc

At this point, project settings can be changed and schema files can be edited as needed.

Creating a Project

Since there are alarge number of options available in the code generation process, ACGUI allows settings to be saved
in project files for reuse. Project files can be created, opened, and saved from the "Project” menu. If no project fileis
explicitly used, adummy project will beimplicitly created and can be saved to afile at alater time.

Project assets, such as ASN.1 schemas and generated source files, are visible in the "Project" window. Project set-
tings can be changed via the Project Settings window, accessible by selecting "Project->Project Settings..." from the
menubar.

Editing Schemas

The central area of the ACGUI window is dedicated to editing ASN.1 schema definition files. To create a new file,
click the "New" button in the toolbar or select "File->New Schema File" in the menus. To open an existing schema
file, either click the "Open" button in the toolbar or select "File->Open File..." from the menus. In both cases, the file
will be added to the project and the editor will show it. Clicking on an ASN.1 schemafile name in the project window
will aso display that filein atab in the editor.

At any point during editing, the schema can be saved and checked for proper syntax by clicking the "Validate" button
in the toolbar.

12
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Compiling

Once aproject has been created and schemas added, the schemas may be compiled. Thisassumesthat atarget language
has been selected in the project. Click the "Compile" button or select "Tools->Compile" from the menus. If any files
have unsaved changed, a dialog box will be displayed prompting the user to save them. Once saved, the compiler will
run, generating source code and related files. From here, changes can continue to be made to the schemaand to project
settings and recompilation done as needed.

Interface

File Edit Project Tools Help

Project 8

D& » B v « 9

Mew Open Remove Savefle Valdate compile Previous Error  Next Error

Untitled
4 Schema/ASN files
ACSE-Lasn
InformationFramework.asn
UsefulDefinitions.asn
Include Directories
Configuration files
» Generated ems

UsefulDefnitions.asn [ | InformabonFramework.asn [ | acsgt.esn [ |

1

2 UsefulDefinitions {jointiso-tu-t ds(3) module(1) usefulDefinitions(0) 3}
3 DEFINITIONS ==

4 BEGIN

S@womam;

11 1D := OBJECT IDENTIFIER
13 s 10 2= {jointiso-itu-t ds(B)}
14

15
16 module 10 = {ds 1}
17

18 serviceElement D = {ds 2}
20 applicationContext D = {ds 3}
?Z attribute Type |0 == {ds 4}

gz attributeSyntax (D = {ds 5}

25
26 objectClass D= {ds B}
27

28

29 algorithm ID:={ds 8}

30

31 abstractSyntax D 2= {ds 9}
32

i3

34
AR daalneratinnalAtribote 0 =

ASN.1Tree =3

Text | Browser

Error Log

> %= ACSE-L
4 % InformationFramewark
> I Types
4 6 Values
# id-at-aliasedEntryName
# id-at-objectClass
# id-mr-distinguishedNameha...
# id-mr-objectldentifieriatch
> 1 Information Object Classes
» %2 Information objects
> %2 Information object sets
> B UsefulDefinitions

2 File Line Column Message

Q1 Parsing ASN.1 definitions..
Q2 Validation was successful

13
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Editor

| UsefulDefinitions.asn E | InformationFramework. asn | ACSE-1.asn |
1 S
2 UsetulDefinitions {jointiso-itu+t ds(b) module(1) usefulDefinitions(0) 3}
3 DEFINITIONS =
4 BEGIN

m

[mn B = R g

9
10
11 1D = OBJECT IDENTIFIER
12
13 dz= 1D 2= {joint-iso-tu-t ds(B)}
14
15
16 module D @={ds 1}
17
18 serviceElement ID = {ds 2}
19
20 applicationContext 1D = {ds 3}
21
22 aftribute Type [0 = {ds 4}
23
24 aftributeSyntax [0 = {ds &}
2h
26 ohjectClass D = {ds B}
27
28
249 algorithm 1D 2= {ds 8}
30
31 abstractzyntax D o= {ds 9}
32
33
34
AR dsaloeratinnalAtribute 0 =
Text Browser

The central part of the ACGUI window is the schema editor. From here, schema files can be viewed and edited. To
begin editing an ASN.1 schema, create a new file or open an existing file via the toolbar or menu. The file will be
added to the current project and shown in the editor.

The editor window is also used to display a schemabrowser for navigating avalidated schema. To display the browser
after validating a schema, click on anitemin the ASN.1 Tree window. The browser will display ahyperlinked version
of the schema, centered on the definition of the selected item. Clicking the names of other defined typesin the browser
will cause their definitions to be shown.

By default, documents are displayed in tabs in the editor. Tabs "Text" and "Browser" at the bottom of the window
are for schema editing and hyperlinked schema browsing, respectively. At the top of the "Text" tab, each schemafile
currently being edited has atab.

Alternatively, ACGUI can display documentsin separate subwindows. To changethis, select "Tools->Options..." from
themenus. Inthe " General" tab of the optionswindow, change " Openfiles’ from"Intabs' to"In MDI windows'. Click
"OK" and restart ACGUI. Now, open files will be displayed as separate windows within the main ACGUI window.
Thisoption is useful for viewing two files simultaneously, for example.
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Project Window

Project

=]

3

Untitled
4 Schema/asiM.] files

ACSE-1.3zn
InformationFramework.asn
LsefulDefinitions.asn

Include Dhrectories
Configuration files
4 Generated ltems

C/C++ files
C#files
lava files
K5D files

The project window allows the user to interact with project assets.

Schema/ASN.1 files

Include directories

Configuration file
Generated Items

Clicking on a schema file or configuration file in the project window will open that file in the editor. A right-click
context menu isalso provided for schemarfiles, include directories, and configuration file for adding or removing these

import definiti

assets from the project.

ASN.1 Tree Window

ASM.1Tree

- &

9

=]

ACSE-1

InformationFramework
-5
b=

Types

Values

% id-at-aliasedEntryMame
# id-at-objectClass

# id-mr-distinguishedMameMa...

# id-mr-objectldentifierfatch
Information Object Classes
Information chjects
Information cbject sets
UsefulDefinitions

Files containing the current project's ASN.1 schema definitions.

Directories containing auxiliary ASN.1 schemafiles. The current project's schemamay
ons from modules defined in an included directory.

An ASN1C compiler configuration file.

A listing of the files generated by the compiler, separated by target language.

»
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Once a schema has been validated or compiled in ACGUI, the ASN.1 Tree window provides an interactive view of
the ASN.1 typesdefined init. At thetop level of the tree, the modules of the schema are shown. Each of these modules
can be expanded to reveal branches for the types, values, information objects, etc. defined in each of them. Clicking
on any node of the tree will show the relevant ASN.1 definition in a built-in browser in the editor window.

Error Log Window

Error Log g X

Clear Save Log

# File Line Column Message

Q1 Parsing ASN.1 definitions..
Q Validation was successful

The Error Log window displays messages related to schema validation and compilation. Whenever a schemais suc-
cessfully validated or compiled, the Error Log will report a success. If an error occurs, an error message will be dis-
played.

In many cases, an error will be associated with a particular portion of the schema being compiled. In these cases,
clicking on an error will open the schema editor to the location that the error occurred. If more than one error is
reported, clicking the"Next Error" and "Previous Error" buttons in the toolbar will move the editor window to the part
of the schemawhere the next or previous error occurred.

When the reported errors are no longer needed, they can be cleared by clicking the "Clear" button in the Error Log
window.

Project Settings

The project settings window is where details such as encoding rules, target language, and code features to generate
are modified.

16
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Output tab

D ASN1C Settings

Qutput Eunction Generation

Application Language Type

@ Mone Oc

ASN, 1 Standard

Additional Translations

Encoding Rules

BER R DER

Output

o
[
f

Project Di

o
[
f

Input Options
[ Perform a lax syntax check

[] cenerate HTML files for input ASN. 1

Constraints and Debugging

O ca+

(® X.680-X.683 - current in force ASN, 1 standards

PER

[ Generate equivalent XML schema

Code Modifications

Ocz O Java () python
(O ¥, 208- previous now withdrawn standard

[ pretty-print ASN. 1

[ Allow ambiguous tags

COER

Cancel

The"Output" tab contains options for selecting atarget language, encoding rules, output directory. In order to compile
a schema, atarget language must be selected under "Application Language Type".

"Additional Translations" contains several options for generating transformed versions of the input schema, such as
HTML or pretty-printed.

"Encoding Rules' allows for one or more encoding rule set to be selected for generated code.

"Input Options" affect how strict the compiler is when parsing the ASN.1 schema.

Depending on the target language selected, additional options are shown.
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C/C++ Output Options

(® Cutput code to .cf\h files based on module names

(O output all code to a single .cf.h file .C .h
(O Cutput each generated function to its own source file

Default integer type: |int32 o

Max lines per file:

Libraries Directory Browse

Browse

| |
Object directory | | Browse
| |
Binaries Directory || |

For C or C++ target languages, " C/C++ Output Options' controls how generated codeis distributed across sourcefiles.

C# Code Crganization
1 output code to directories based on module names

Code generation option: |One .cs file per type  ~ | File name:

Binaries Directory | | Browse

Libraries Directory | | Browse

For C#, "C# Code Organization” controls how generated code is distributed across source files and how files are
organized into directories.

Java Code Organization

[ output code to directories based on module names

Class directary | | Browse

For Java, "Java Code Organization" allows generated code to be organized into directories based on the ASN.1 module
for which they were generated. Alternatively, generated files will be placed directly into the output directory.
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Function Generation tab

D ASN1C Settings ? x

Qutput Eunction Generation Constraints and Debugging Code Modifications CjC++ Build Options
Generated Function Types

Printing Functions
Encoding

Decoding [] standard Output [ Streaming [] string
] comparison
Col
[ copy Print Format (®) Bracetext () Details
[] stream
Specify PDU Types
(® Default (unreferenced types) O Al () selected

nter PDU type names

Sample Program Generation

[] specify a PDU for the sample programs

[] Generate test code to populate data structures with random data at run-time

[] Generate test code to populate data structures with random hard-coded values at compile time
|:| Generate reader sample program |:| Generate writer sample program

|:| Generate dient sample program |:| Generate server sample program

[] Generate program from template

C/C++ Generated Functions
Generate Initialization Functions
|:| Generate Memory Free Functions

[] Generate Mamed Bit Macros

Save Cancel

The "Function Generation" tab provides settings for what functionality to include in generated code. Options under
"Generated Function Types" provide granular control of what functions to generate. The printing functions allow for
various printing schemes to be generated, such as print-to-string and print-to-standard-output, and how the printed
data should be formatted.

The "Specify PDU Types" area provides options for telling ASN1C what productions to choose as PDUSs.

"Sample Program Generation" allows simple encoding and decoding programs, which demonstrate using the generated
code, to be generated. The sample writer program can optionally encode randomly-generated test data.

Depending on the target language selected, additional options may be shown here.
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C/C++ Generated Functions
Generate Initialization Functions
|:| Generate Memory Free Functions

] Generate Mamed Bit Macros

For C and C++, additional functionsfor memory management and macrosfor dealing with named bitsin BIT STRINGs
can be generated. Initialization functions are generated by default. They may be turned off in the window.

Java Function Options
[] Generate getter and setter methods
[] Generate metadata methods

For Java, get and set methods can be generated for members of generated classes. It isalso possible to generate methods
that can fetch certain types of metadata (for example, if an element is optional). A similar option exists for C#.
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Constraints and Debugging tab

'

Qutput Function Generation Constraints and Debugging Code Modifications C# Build Cptions
Constraints
|:| Do not generate code supporting contents constraints
[] Do not generate constraint checks |
[] Enable strict constraint checks
[] Generate code to handle table constraints

Debugging and Event Handling

[[] Generate code to invoke event handler callback functions
|:| Do not generate type structures

[] add tracing diagnostic messages to code

[] Enable output of compilation warning messages

Save Cancel

The "Constraints and Debugging” tab holds settings related to constraint handling, event handling, and logging in
generated code. Under "Constraints', varioustypes of constraint checks can be added or removed from generated code.

In "Debugging and Event Handling", settings for adding debug tracing and event hooks are available. In addition to
enabling event callbacks, generation of type structures can also be disabled, in which case generated decode function-
ality will simply call user-created event handlers and not perform its own decoding operation.
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Code Modifications tab

'

Output Function Generation Constraints and Debuaging Code Modifications C# Build Options
Space Optimizations
|:| Generate compact code
[] Do not generate code to save/restore unknawn extensions
[] Do not generate types for items embedded in information objects
[] Do not generate XML namespaces for ASM. 1 modules
[[] Generate shart form of type names

Other Options

Automatically create unigue names for duplicate items
[] Do not add date stamp to generated files
[] Generate code for dependent type definitions

Save Cancel

Under the"Code Maodifications' tab are anumber of optionsfor generating simplified code. In " Space Optimizations®,
these mainly regard the removal of unwanted or unneeded functionality and shortening names of generated types.

"Other Options" provide several miscellaneous settings, including the option of generating code for types that have
been imported into the current schema.

Additional code modification options that are language-specific are shown in a separate tab next to the "Code Modi-
fications' tab. The lable on this tab will change based on the language selected. For C/C++, it isasfollows:
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F A
@ ASNIC Settings [ 2 S

I_gulput I Function Generation Constraints and Debugging Code Modifications | CiC++ | Build Options

C/C++ Code Modifications

[7] add & header guard prefix

7] Add a C++ namespace

SEQUEMCE OF/SET OF use: @ default ) linkedlist (O dynamicarray (O static array
|| Generate static member variables in choice constructs
[7] Use enumerated types instead of integers

[7] Generate fully qualified enumerated constants

|| pisable fixed sizing for small bit strings

[ suppart indefinite PER lengths

[] Pad PER BIT STRING-tontained values

[”] Generate code compatible with 64-bit architectures

|| Generate code that uses C++11 features induding STL

[ Save ][ Cancel ]

In this case, code modifications include several settings for adjusting how ASN.1 types are mapped to native C/C+
+ types.

For C#, the tab is as follows:
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| D
Qutput Function Generation Constraints and Debugging Code Modifications C= Build Options

C# Code Modifications
[] specify namespace

[] specify namespace prefix |

Save Cancel

Inthis, modificationsallow for mani pul ating the namespace into which codeis generated. The Javatab containssimilar
options.

Build Options tab

When atarget language other than "None" is selected, an additional "Build Options' tab contains language environ-
ment-specific settings for generating makefiles and build scripts.

For C or C++, the window is as follows:
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D ASN1C Settings ? X

Qutput  Function Generation Constraints and Debugging ~ Code Modifications ~ C/C++  Build Options

[ Generate Visual Studio Project [ Generate Makefiles
Windows (nmake)

GNU

C/fC++ Compile Optimization
(® Default

() Space Optimization

a8) (O Speed (Time) Optimization
[ Build Libraries
Generate static libraries
Generate shared libraries

Generate multi-threaded libraries

[ Link applications using shared libraries

Link applications against 64-bit libraries

Save Cancel

A makefile can be generated in either Windows or GNU format. For Windows, a Visual Studio project can also be
generated. Under "Build Libraries', which will generate the build script to build a library rather than an executable,
the desired variety of library can be selected.

"C/C++ Compile Optimization" allows for setting whether Space or Time optimization qualifiers should be added to
the C compilation command-line in the makefile.

For C#, the following options are displayed:
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D ASN1C Settings ? X
Qutput  Function Generation Constraints and Debugging ~ Code Modifications ~ ©#  Build Options

Build Options
[[] Generate a list of .cs fles {in <modulename .mk)

[[] Generate a makefie
[ Generate a Visual Studio Project

[ strongly named key file:

Save Cancel

Similarly for C#, a makefile or Visual Studio project can be created, optionally including a*.mk file listing the files
generated. An option to specify astrongly named key file also exists.

For Java, the following is displayed:
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9

Qutput Function Generation Constraints and Debugging Code Modifications Java Build Options

Build Options

[] Generate a list of .java files {in <modulename =, mk)
[] Generate an Ant build script
[] Generate a batch file or shell script

Save Cancel

Javacan also provide a*.mk generated file list, aswell as Ant build script and a batch or shell script.

For Python, the following is displayed:
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D ASN1C Settings ? b

Qutput Function Generation Constraints and Debugging Code Modifications Build Options

Build Options

[] create a batch file or shell script to generate Python code

Save Cancel

For Python ASN1C can create a batch file (Windows) or shell script (non-Windows) that will generate the Python
code as set up by the GUI settings.

For Go, the following is displayed:
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D ASNIC Settings ? By

Qutput Function Generation Constraints and Debugging Code Modifications Build Options

Build Options

[] create a makefile to generate Go code
[] Create a 150N file with random test data
[] pon't create a main.go file

Cancel

The Go code generator can create a makefile to generate and build Go code. The generator can also create a JSON
file with random test data. Telling the generator not to create a main.go file (for instance, if there already is one that
has been modified) is aso an option.
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A Go source file with extension '.go’ will be generated for most ASN.1 modules defined in the ASN.1 sourcefile. If a
modul e does not contain any ASN.1 typesthat would trigger generating a Go type or value, then no Go fileisgenerated.

General Hierarchy of Generated Go Source
Files

When Go code is generated, a standard directory structure is created to hold the generated files which form a Go
module. At the root level, the main.go and go.mod files are generated. Under that is asnlgen subdirectory, in which
the generated Go files are stored. Below the asnlgen subdirectory isan asnirt subdirectory, in which the required base
run-time source files are stored. Executing “go build” will build the full package.

General Form of a Generated Go Source File

A generated Go file beginswith package asnlgen. All generated Go code isincluded in the asnlgen package.

After that is an import statement, which will import the base run-time package, asnlrt, and any required built-in Go
packages. Thisisfollowed by type and constant definitions. Seethe“ASN.1 To Go Type Mappings’ section for details
on the mapping of ASN.1 typesto Go types.

For PER, type-specific encode and decode functions are generated. For JISON, custom marshal and unmarshal functions
are generated for some types. The built-in Go marshaling logic is used wherever possible to do the JSON conversion.
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(main.go)

Go code is normally generated from within the golang subdirectory in an ASN1C installation. At the main level,
main.go and go.mod files are generated. The main.go file is atemplate file for using the files in the asnlgen package.
The asnlgen package source is generated into an asnlgen subdirectory beneath the top-level directory. The main.go
file contains a sample writer section to encode a datarecord of the chosen Protocol Data Unit (PDU) type and to afile.
The reader section reads decodes from the file and prints the results. Each is invoked by running the main program
with an argument of ‘writer' or 'reader’, respectively.

By default, the main.go writer section contains a TODO comment to remind the user that a data variable of the PDU
type needs to be populated prior to encoding. If the -test command-line option is specified, code will be added to
populate the PDU variable with random test data.

The procedure to generate and build Go source code is rather straightforward:

1. Invoke the asnlc compiler on your ASN.1 source file(s) to generate Go source code. For example: asnlc test.asn
-go -per

2. Invoke 'go build' to run the Go compiler to build the generated package.
That isit. If successful, an executable file should have been created which can be run with the writer or reader option.

Note that it is possible to use the -make command-line option to generate a makefile for future compilations. The user
should also be careful to use the -no-go-main option on future compilations so as to not regenerate the main.go file
in the event it was edited by the user.

31



Chapter 6. ASN.1 To Go Type Mappings
Type Mappings
BOOLEAN

A Go type is generated for the ASN.1 BOOLEAN type which eguates the ASN.1 type assignment to the built-in Go
bool type. For example:

ASN.1:

MyBool ::= BOOLEAN
Generated Go code:

type MyBool bool

If a BOOLEAN type is referenced directly in an element within a constructed type, the Go bool type is referenced
directly.

INTEGER

A Go typeis generated for the ASN.1 INTEGER type which equates the ASN.1 type assignment to a built-in Go 64-
bit integer type. For an unconstrained integer type, the Go type used is a signed 64-bit integer (int64). For example:

ASN.1:
MyInt ::= | NTEGCER
Generated Go code:
type Mylnt int64
If aconstraint constrains the value to a nonnegative range, an unsigned 64-bit integer typeis used (uint64):
ASN.1:
MU nt ::= | NTEGER (O0..9)
Generated Go code:
type Myl nt uint64
Note that no attempt is made to used smaller integer types for smaller ranges.

If an INTEGER typeis referenced directly in an element within a constructed type, the Go integer type is referenced
directly.

If the INTEGER type contains a list of named numbers, Go constants are generated for each number, the same asis
done for the ASN.1 ENUMERATED type.

BIT STRING

The ASN.1BIT STRING typeismapped to the Go BitString type defined withinthe ASN.1 run-time (asnlrt.BitString).
Thisisin turn mapped to the encoding/asnl.BitString from the Go standard library. For example:
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ASN.1:

MyBitStr ::= BIT STRING
Generated Go code:

type MyBitStr asnlrt.BitString

Bits are specified in the Bytes field in most-significant bit order. For example, the bit string '1'B (consisting of asingle
bit which is set) would be represented using BitLength = 1 and Bytes being a dlice of 1 byte, set to 0x80.

Named Bits

Inthe ASN.1 standard, it is possibleto define anamed bit string that specifiesnamesfor different bit positions. ASN1C
provides support for thistype by generating Go constants and run-time functions that can be used to set, clear, or test
these named bits. These constants equate the bit name to the bit number defined in the specification. They can be used
with the SetBit, ClearBit, and TestBit run-time functions to set, clear, and test the named bits.

Contents Constraint

It ispossibleto specify acontents constraint on aBIT STRING type using the CONTAINING keyword. Thisindicates
that the encoded contents of the specified type should be packed within the BIT STRING container. An example of
this type of constraint is asfollows:

Contai ningBS ::= BIT STRI NG ( CONTAI NI NG | NTEGER)

ASNI1C will generate a type definition that references the type that is within the containing constraint. In this case,
that would be INTEGER; therefore, the Go type for INTEGER would be used, which isint64. This direct use of the
containing type can be suppressed through the use of the -noContaining command-lineargument. I nthat case, anormal
BIT STRING type will be used and it will be the user's responsibility to do the necessary packing and unpacking
operations to encode and decode the variable correctly.

OCTET STRING

The ASN.1 OCTET STRING type is mapped to the Go OctetString type defined within the ASN.1 run-time
(asnlrt.OctetString). Thisisin turn mapped to a byte dlice. For example:

ASN.1:
MyQct Str @ : = OCTET STRI NG
Generated Go code:

type MyQct Str asnlrt. Cctet String

Contents Constraint

It is possible to specify a contents constraint on an OCTET STRING type using the CONTAINING keyword. This
indicates that the encoded contents of the specified type should be packed within the OCTET STRING container. An
example of thistype of constraint is as follows:

Cont ai ni ngOS :: = OCTET STRI NG ( CONTAI NI NG | NTEGER)

ASNI1C will generate a type definition that references the type that is within the containing constraint. In this case,
that would be INTEGER; therefore, the Go type for INTEGER would be used, which is int64. This direct use of
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the containing type can be suppressed through the use of the -noContaining command-line argument. In that case,
anorma OCTET STRING type will be used and it will be the user's responsibility to do the necessary packing and
unpacking operations to encode and decode the variable correctly.

ENUMERATED

The Go mapping for an ASN.1 ENUMERATED typeis the same as for INTEGER. By default, uint64 is used. If the
ENUMERATED type contains negative-valueidentifiers, then int64 is used. Go constants are generated for each of the
enumerated identifiers. The constant names consist of the type name concatanated with the enumerated identifier name
in order to provide unique names. Note that for Go, camel-case is used in the generated identifiers and underscores
are not used.

If the enumerated typeis extensible, a special UNKNOWN identifier constant is added to the enumerated contant list.

If an enumerated type is referenced directly in an element within a constructed type, a compiler-generated type is
generated for it consisting of the constructed type name concatanated with the element name to form a camel-cased
identifer. Thisidentifier isthen used as the prefix for generated enumerated identifiers.

Example - Enumerated Type Assignment
ASN.1:

MyEnum : : = ENUMERATED { red(0), green(l), blue(2), ... }
Generated Go code:

type MyEnum ui nt 64
const (
MyEnunRed = 0
MyEnuntx een =
MyEnunBl ue = 2
My EnumUNKNOMN = 3

)

1

Example - Enumerated Type Referenced in Element
ASN.1:
MySeq :: = SEQUENCE {
enum ENUMERATED { a, b, c }
}
Generated Go code:

type MySeqEnum ui nt 64

const (
MySegEnumA = 0O
MySegEnunB = 1
MySegEnunC = 2

)

type MySeq struct {
Enum MySeqEnum
}
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NULL

A Go typeis generated for the ASN.1 NULL type which equates the ASN.1 type assignment to the built-in Go bool
type. The purpose of having atype for it is so that it can act as a placeholder to denote the presence or absense of this
type within a constructed type. For example, if it used in an optional element or within a choice construct.

If aNULL typeisreferenced directly in an element within a constructed type, the Go bool type is referenced directly.

Example
ASN.1:

MyNul I ::= NULL
Generated Go code:

type MyNull bool

OBJECT IDENTIFIER

The ASN.1 OBJECT IDENTIFIER typeis mapped to the Go Objectldentifier type defined within the ASN.1 run-time
(asnlrt.Objectldentifier). Thisin turn is mapped to a uint64 slice ([Juint64), with each uint64 representing a single
subidentifier. For example:

ASN.1:
MyQ D ::= OBJECT | DENTI FI ER
Generated Go code:

type MO D asnlrt. bjectlidentifier

RELATIVE-OID

The ASN.1 RELATIVE-OID type mapping is the same as described above for OBJECT IDENTIFIER.

REAL

The ASN.1 REAL type is mapped to the Go Real type defined within the ASN.1 run-time (asnlrt.Real). Thisin turn
is mapped to is mapped to the Go built-in float64 type.

If the REAL typeis constrained to base 10 values, it is mapped to the Go RealBasel0 type defined within the ASN.1
run-time (asnlrt.RealBasel0). Thisin turn is mapped to is mapped to the Go built-in string type.

Example
ASN.1:
M/Real ::= REAL
M/Real 10 ::= REAL(O0 | WTH COMPONENTS { ..., base (10) })

Generated Go code:

type MyReal asnlrt. Real
type MyReal 10 asnlrt. Real BaselO
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SEQUENCE/SET

An ASN.1 SEQUENCE or SET typeisa constructed type consisting of a series of element definitions; each element
has an assigned ASN.1 type. An ASN.1 SEQUENCE or SET is mapped to a Go struct type with each ASN.1 element
having an equivalent Go element definition. The general formis as follows:

ASN.1 production:
<nane> ::= SEQUENCE ({

<el enent 1- nane> <el enent 1-type>,
<el enent 2- nane> <el enent 2-type>,

}
Generated Go code:

type <name> struct {
<el enent 1- nane> <typel>
<el enent 2- nane> <type2>

The <t ypel> and <t ype?2 placeholders represent the Go types for the ASN.1 types <el enent 1-t ype> and
<el ement 1- t ype>, respectively.

Hereisan example:

ASN.1L:
A ::= SEQUENCE {
X SEQUENCE {
al | NTEGER,
a2 BOOLEAN
} )
y OCTET STRING (Sl ZE (10))
}

Generated Go code:

type AX struct ({

Al int64

A2 bool
}
type A struct {

X AX

Y asnlrt.Cctet String
}

First, note that the Go field names in the struct begin with uppercase letters. This means the names are exported for
use outside of the package in which they are defined.

Second, natice that we generated type AX, even though no such type was defined in the ASN.1. This is the result
of using a nested, constructed type in the ASN.1. The elementsin a SEQUENCE or SET can be of any ASN.1 type,
including other constructed types. Sometimes, one constructed type definition is nested inside another, rather than
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defining aseparate type and referencing it by name. For example, it is possible to nest a SEQUENCE definition within
another SEQUENCE definition (see el ement x in the above example).

The ASNI1C compiler first recursively pulls al nested constructed elements out of the SEQUENCE and
forms new internal types. The internal ASN.1 names of these types are of the form <nane>_<el enent -
nanel> <el enment name2>_ ... <el enent - nanmeN>. In the above example, the compiler internally created
atype for element x: A_x. The compiler then generates code as if the ASN.1 had been written without nesting, using
the type definitions it created internally. Transforming the ASN.1 name to a Go name produced AX.

In the case of nesting levels greater than two, all of the intermediate element names are used to form the final name.
For example, consider the following type definition that contains three nesting levels:

X 1= SEQUENCE {
a SEQUENCE ({
aa SEQUENCE { x | NTEGER, y BOCLEAN },
bb | NTEGER
}
}
In this case, the generation of compiler-generated types results in the following equivalent type definitions:
X-a-aa ::= SEQUENCE { x | NTEGER, y BOCOLEAN }
X-a ::= SEQUENCE { aa X-a-aa, bb | NTECGER }
X ::= SEQUENCE { X-a a }

Note that the name for the aa element typeis X- a- aa. It contains both the namefor a (at level 1) and aa (at level 2).
The concatanation of all of the intermediate element names can lead to very long names in some cases. To get around
the problem, the -shortnames command-line option can be used to form shorter names. In this case, only the type
name and the last element name are used. In the example above, this would lead to an element name of X- aa. The
disadvantage of thisisthat the names may not always be unique. If using this option results in non-unique names, an
_n suffix isadded where n is a sequential number to make the names unique.

Although the compiler can handle embedded constructed types within productions, it is generally not considered good
style to define productions this way. It is much better to manually define the constructed types for use in the final
production definition. For example, the production defined at the start of this section can be rewritten as the following
set of productions:

X 1= SEQUENCE {
al | NTEGER,
a2 BOOLEAN

}

A ::= SEQUENCE {
X X

y OCTET STRING (S| ZE (10))
}

This makes the generated code easier to understand for the end user.

OPTIONAL keyword

Elements within a sequence can be declared to be optional using the OPTIONAL keyword. This indicates that the
element is not required. Optional elements are handled in Go using pointer types. If the pointer to the element value
isnil, it means the element is not present.
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For example, the elements in the following production are marked as optional:

Aseq ::= SEQUENCE ({
X | NTEGER OPTI ONAL,
y BOCLEAN OPTI ONAL
}

In this case, the following Go type is generated:

type Aseq struct {
X *int64
Y *bool

}

When this structure is populated for encoding, if the element is present, the developer must set the pointer value to
point at avalue. This can be done using new or by assigning the value to alocal variable and then storing the address
of the variable in the generated structure. Conversely, when a message is decoded into this structure, the developer
must test to seeif the elements are nil to seeif they were present in the message.

DEFAULT keyword

The DEFAULT keyword allows a default value to be specified for elements within the SEQUENCE. ASN1C will
generate a non-pointer type for elements using DEFAULT if the type is one of several simple types (BOOLEAN,
INTEGER, ENUMERATED, REAL, BIT STRING, OCTET STRING, and character string types). In other cases,
ASNI1C will generate a pointer type, the same as it does for an element with OPTIONAL; anil pointer is interpreted
as representing the default value.

For PER, elements set to their default value MUST be encoded as ABSENT. In the cases where ASN1C generates
a non-pointer type, the compiler automatically generates code to meet this requirement. In the cases where ASN1C
generates a pointer type, the programmer must set the pointer to nil rather than popul ate the field with the default value.

Extension Elements

If the SEQUENCE type contains an open extensionfield (i.e., a... at theend of thespecificationor a..., ... inthemiddle),
aspecia element will be inserted to capture encoded extension elements for inclusion in the final encoded message.
This element will be of type [][] byte and have the name ExtEleml. This holds an array of encoded components.

The-noOpenExt command line option can be used to alter thisdefault behavior. If thisoptionisspecified, the ExtEleml
element is not included in the generated structure; any extension data that may be present in a decoded message is
skipped.

If the SEQUENCE type contains an extension marker and extension elements, then the actual extension elements will
be present in addition to the ExtEleml element. These elements will be treated as optional elements whether they
were declared that way or not. The reason is because a version 1 message could be received that does not contain
the elements.

If version brackets are present, astruct is generated for each extension element group. This struct has type name of the
form <container>ExtGrpV<n> where <container> is the name of the container type and <n> is the version humber
of the group. This type isthen referenced as an optional element in the container type.

An example of atype with version bracketsis as follows:

Test Sequence ::= SEQUENCE {
i tem code | NTEGER (0. .254),
i tem nane | A5String (SIZE (3..10)) OPTI ONAL,
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R
ur gency ENUMERATED { normal, high } DEFAULT nor nal ,
[[ alternate-item code | NTEGER (0. . 254),
alternate-item nane | A5String (SIZE (3..10)) OPTI ONAL

1]
}

In this case, a structure named Test SequenceExt G pV3 is generated for the items in the version brackets. The
number 3 is used because 2 would be the version extension number of the urgency field. The generated Go types for
this construct would be as follows:

type Test SequenceExt G pV3 struct ({
Al ternat el temCode uint 64
Al ternateltemName *string

}

type Test Sequence struct ({
| t enCode ui nt 64
I temName *string
Urgency *uint 64
Ext G pV3 *Test SequenceExt G pV3
ExtEleml [][]byte
}

The presence or absence of the entire version block would be determined by whether the ExtGrpV 3 element pointer
is set.

SEQUENCE OF/SET OF

An ASN.1 SEQUENCE OF or SET OF type is mapped to a Go slice. The general form is []<element type> where
<element type> would be replaced with the Go type of the SEQUENCE OF element.

SEQUENCE or SET OF Element in a Constructed Type

If an element in a SEQUENCE, SET, or CHOICE directly references a SEQUENCE OF or SET OF type, a dlice
type is generated inline. A separate type is not generated to be referenced by the element. For example, consider the
following type definitions:

SeqOf I nt ::= SEQUENCE OF | NTEGER

Seq ::= SEQUENCE {
a SeqOfInt,
b SEQUENCE OF BOOLEAN

}
Thisresultsin the following Go types being generated:

type SeqOfInt []int64

type Seq struct {
A SeqOf I nt
B [] bool

}
Note that a separate typeis not generated for the inline SEQUENCE OF BOOLEAN, the bool sliceisgenerated inline.
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SEQUENCE OF Constructed Type

Aswith other constructed types, the<Type> in SEQUENCE OF Type canbeany ASN.1 type, including constructed
types. Therefore, it is possible to have a SEQUENCE OF SEQUENCE, SEQUENCE OF CHOICE, etc.

In such cases, the compiler interally creates an ASN.1 type for the nested, constructed type. The format of the name
for thistypeisasfollows:

<Pr odNane>El enent
In this definition, <Pr odNane> refers to the Go name of the production containing the SEQUENCE OF type.
For example, asimple (and very common) single level nested SEQUENCE OF construct might be as follows:
A ::= SEQUENCE OF SEQUENCE { a | NTEGER, b BOOLEAN }

In this case, atypeis generated for the element of the SEQUENCE OF production. Internally, thisistransformed into
the equivalent ASN.1:

A-element ::= SEQUENCE { a INTEGER, b BOOLEAN }
A ::= SEQUENCE COF A-el enment

These types are then converted into the equivalent Go types using the standard mapping that was previously described.

SET OF

The ASN.1 SET OF type is mapped to adice type, just the same as described previously for SEQUENCE OF.

CHOICE

The ASN.1 CHOICE type is converted into a Go struct containing an integer for the choice tag value (T) followed
by a struct (U) with a field for each of the CHOICE elements. This differs from C/C++, where a union type is used
for the set of alternatives. Thereis no union type in Go, so a struct containing pointer values for all of the alternatives
isused. The T field indicates which of the alternatives is chosen and which of the fields in the U struct shall be non-
nil; exactly one field shall be non-nil at atime.

The tag value is smply a sequential number starting at one for each aternative in the CHOICE. A Go constant is
generated for each of these values. The format of this constant is <nane><el enent - nane>TAG where <nane>
isthe name of the ASN.1 production and <el enent - nanme> isthe name of the CHOICE aternative.

The fields of the U struct, corresponding to the aternatives for the CHOICE type, are generated much the same as
for the elements of a SEQUENCE type (described earlier), except that pointer types are used. The compiler internally
pulls out any nested constructed types and creates an ASN.1 type for it, and that is reflected in the generated code.

ASN.1 production:
<nane> ::= CHO CE {

<el ement 1- name> <el enment 1-type>,
<el ement 2- name> <el enment 2-type>,

}

Generated Go code:
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const (
<nane>_<el enment 1- name>TAG = 1
<nane>_<el enment 2- name>TAG = 2

)

type <name> struct ({
T uint 64
U struct {
<typel> *<el ement 1- nanme>
<type2> *<el ement 2- nanme>

}
Open Type

An Open Type as defined in the X.680 standard is specified as areference to a Type Field in an Information Object
Class. The most common form of this is when the Type field in the built-in TYPE-IDENTIFIER class is referenced
asfollows:

TYPE- | DENTI FI ER. &Type
See the section in this document on Information Objects for a more detailed explanation.

The Open Type is converted into a Go byte slice ([]byte). The dlice is assumed to contain previously encoded ASN.1
data. When a message containing an open type is decoded, a copy of the encoded data is made.

If the -tables or -table-unions command line option is selected and the ASN.1 type definition references a table con-
straint, the code generated isdifferent. Inthiscase, instead of abytedlice, aunion-type structureisused, similar to what
is done for a CHOICE type. Each information object in the information object set referenced by the table constraint
specifies an actual ASN.1 type that can be used for the open type; taken together, these objects represent all of the
possible alternatives for the open type.

Character String Types

All ASN.1 character string types, including multi-byte types such as BMPString and Universal String, are mapped to
the Go string type. The Go string will be interpreted by the generated code as UTF-8.

The useful character string typesin ASN.1 are asfollows:

UTF8St ri ng
NumericString
Printabl eString

[ UNI VERSAL 12] I MPLICIT OCTET STRI NG
[ UNI VERSAL 18] IMPLICIT I ASString
[ UNI VERSAL 19] IMPLICIT I ASString

T61String [ UNI VERSAL 20] I MPLICIT OCTET STRI NG
Vi deot exString [ UNI VERSAL 21] I MPLICIT OCTET STRI NG
| A5String [ UNI VERSAL 22] I MPLICIT OCTET STRI NG
UTCTi e [ UN VERSAL 23] |IMPLICIT GeneralizedTinme

Ceneral i zedTi me
GraphicString
Vi sibleString
Ceneral String
Uni versal Stri ng
BMPSt ri ng

[ UNl VERSAL 24] IMPLICIT I ASString

[ UNI VERSAL 25] I MPLICIT OCTET STRI NG
[ UNI VERSAL 26] | MPLICIT OCTET STRI NG
[ UNI VERSAL 27] I MPLICIT OCTET STRI NG
[ UNI VERSAL 28] I MPLICIT OCTET STRI NG
[ UNI VERSAL 30] |IMPLICIT OCTET STRI NG
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nj ectDescriptor ::= [UNIVERSAL 7] IMPLICIT GaphicString

Time String Types

The ASN.1 GeneralizedTime and UTCTime types are mapped to the Go string type.

EXTERNAL

The ASN.1 EXTERNAL type is a useful type used to include non-ASN.1 or other data within an ASN.1 encoded
message. Thistypeis described using the following ASN.1 SEQUENCE:

EXTERNAL ::= [UNI VERSAL 8] | MPLICI T SEQUENCE {

di rect-reference OBJECT | DENTI FI ER OPTI ONAL,

i ndirect-reference | NTEGER OPTI ONAL,

dat a- val ue- descri ptor Obj ectDescri ptor OPTI ONAL,

encodi ng CHO CE {
si ngl e- ASN1-type [0] ABSTRACT- SYNTAX. &Type,
octet-aligned [1] IMPLICI T CCTET STRI NG
arbitrary [2] IMPLICIT BIT STRI NG

}
The ASN.1 EXTERNAL type is mapped to a Go struct, generated from the above SEQUENCE definition.

EMBEDDED PDV

The ASN.1 EMBEDDED PDV typeisauseful type used to include non-ASN.1 or other datawithin an ASN.1 encoded
message. Thistype is described using the following ASN.1 SEQUENCE:

EnbeddedPDV ::= [UNI VERSAL 11] | MPLICI T SEQUENCE {
identification CHO CE {
synt axes SEQUENCE {
abstract OBJECT | DENTI FI ER,
transfer OBJECT | DENTI FI ER
}l
syntax OBJECT | DENTI FI ER,
presentation-context-id | NTEGER,
cont ext - negoti ati on SEQUENCE {
presentation-context-id | NTEGER,
transfer-syntax OBJECT | DENTI FI ER
}l
transfer-syntax OBJECT | DENTI FI ER,
fixed NULL
}l
dat a- val ue OCTET STRI NG

}
The ASN.1 EMBEDDED PDV type is mapped to a Go struct, generated from the above SEQUENCE definition.
Parameterized Types
The ASN1C compiler can parse parameterized type definitions and references as specified in the X.683 standard.

These types allow dummy parameters to be declared that will be replaced with actual parameters when the type is
referenced. Thisis similar to templatesin C++.
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A simple and common example of the use of parameterized types is the declaration of an upper bound on a sized
type asfollows:

Si zedQct et Stri ng{| NTEGER ub} ::= OCTET STRING (SIZE (1..ub))

In this definition, ub would be replaced with an actual value when the type is referenced. For example, a sized octet
string with an upper bound of 32 would be declared as follows:

OctetString32 ::= SizedCctet String{32}

The compiler would handle this just as if the original type was declared to be an octet string of size 1 to 32. That is,
it will map the type to a go byte slice ([]byte) and do constraint checks before encoding and after decoding to ensure
the value is within the specified range.

Another common example of parameterization isthe substitution of a given typeinside acommon container type. For
example, security specifications frequently contain a'signed' parameterized type that allows a digital signature to be
applied to other types. An example of thisis asfollows:

SI GNED { ToBeSigned } ::= SEQUENCE ({
t oBeSi gned ToBeSi gned,
algorithmO D OBJECT | DENTI FI ER,
par ant Par ars,
signature BI T STRI NG

}

An example of areference to this definition would be as follows:
Si gnedNane ::= SIGNED { Nane }
where Nane would be another type defined el sewhere within the module.
The compiler performs the substitution to create the proper Go type for Si gnedNane:

type SignedNanme struct {
ToBeSi gned Nane
Al gorithm D []uint64
Par ans Par ans
Signature asnl.BitString

}

When processing parameterized type definitions, the compiler will first look to seeif the parameters are actually used
in the final generated code. If not, they will smply be discarded and the parameterized type converted to a normal
type reference. For example, when used with information objects, parameterized types are frequently used to pass
information object set definitions to impose table constraints on the final type. Since table constraints do not affect
the code that is generated by the compiler when table constraint code generation is not enabled, the parameterized
type definition is reduced to anormal type definition and references to it are handled in the same way as defined type
references. This can lead to asignificant reduction in generated code in cases where a parameterized typeisreferenced
over and over again.

For example, consider the following oft-repeated pattern from the UMTS 3GPP specifications:

Protocol | E-Fi el d { RANAP- PROTOCOL- 1 ES : | EsSet Parant} ::= SEQUENCE ({
id RANAP- PROTOCOL- | ES. & d ({! EsSet Parant),
criticality RANAP- PROTOCCL- | ES. &criticality ({l|EsSetParam{@d}),
val ue RANAP- PROTOCCL- | ES. &Val ue ({1 EsSet Param{ @ d})
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}

Inthiscase, | Es Set Par amrefersto aninformation object set specification that constrainsthe valuesthat are allowed
to be passed for any giveninstance of atypereferencingaPr ot ocol | E- Fi el d. Thecompiler doesnot add any extra
codeto check for these values, so the parameter can be discarded (notethat thisisnot trueif the -tables compiler option
is specified). After processing the Information Object Class references within the construct (refer to the section on
Information Objects for information on how thisis done), the reduced definition for Pr ot ocol | E- Fi el d becomes
the following:
Protocol IE-Field ::= SEQUENCE {
id Protocol | E-1D,
criticality Criticality,
val ue ASN. 1 OPEN TYPE
}

Referencesto the field are simply replaced with areference to the Pr ot ocol | D- Fi el d type.

If -tablesis specified, the parameters are used and a new type instance is created in accordance with the rules above.

Value Mappings

ASNI1C can parse any type of ASN.1 value specification, but it will only generate code for following value specifi-
cations:

« BOOLEAN

* INTEGER

* REAL

« ENUMERATED

* Binary String

» Hexadecimal String
 Character String

* OBJECT IDENTIFER

ASN.1 value specifications are mapped to Go constant declarations of varioustypes with the name transformed to start
with prefix 'Asnlv' followed by the value name transformed as per Go naming rules.

BOOLEAN Value

A BOOLEAN value is mapped to a Go true or false constant declaration:
ASN.1 production:

<name> BOOLEAN ::= <val ue>
Generated code:

const Asnlv<nane> bool = <val ue>;
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ASN.1 BOOLEAN values are the uppercase names TRUE and FALSE. The equivalent Go names are true and false.

INTEGER Value

An INTEGER typeis mapped to a Go integer value constant:
ASN.1 production:

<nanme> | NTEGER :: = <val ue>
Generated code:

const Asnlv<nane> int64 = <val ue>

If the integer typeis constrained to be nonnegative, than uint64 is used as the Go type for the constant.

REAL Value

A REAL type value is mapped to a Go floating point constant:
ASN.1 production:

<name> REAL ::= <val ue>
Generated code:

const Asnlv<nane> fl oat64 = <val ue>

ENUMERATED Value

The mapping of an ASN.1 enumerated value declaration to Go isto an integer constant.
ASN.1 production:

<name> <Enumlype> ::= <val ue>
Generated code:

const <name> = <int val ue>

Where <int value> is the integer value associated with the ASN.1 enumerated value.

BIT STRING Value

ASN.1 values of type BIT STRING are mapped to Go variables of type asnl.BitString. The ASN.1 values may be
defined using binary strings, hexadecimal strings, or using sets of named bits:

ASN.1 production:
<nanme> BIT STRING ::= '<bhstring>'B

Generated code :
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var Asnlv<nanme> asnl.BitString = asnl.BitString{ BitLength: <len> Bytes: []byte{<data>

where <len> would be the length in bits and <data> would be a comma-separated list of hexadeciaml byte constants.

OCTET STRING Value

ASN.1 values of type OCTET STRING are mapped to Go variables of type []byte. The ASN.1 values may be defined
using binary or hexadecimal strings. If abinary string is used and the bit count is not evenly divisible by eight, the last
byte is zero-padded on the right with zero bits to form afull byte.
ASN.1 production:

<nane> OCTET STRING ::= '<hstring>H
Generated code:

var Asnlv<nane> []byte = []byte{<data>}}

where <data> would be a comma-separated list of hexadeciaml byte constants.

Character String Value

All ASN.1 character string type values are mapped to Go string constants.
ASN.1 production:

<nane> <string-type> ::= <val ue>
Generated code:

const Asnlv<nanme> string = <val ue>

Object Identifier Value Specification

ASN.1 values of type OCTET STRING are mapped to Go variables of type [Juint64.
ASN.1 production:
<nane> OBJECT | DENTI FI ER ::= <val ue>
Generated code:
var Asnlv<nane> [Juint64 = []uint64{<arcs}>;
Where <arcs> is a comma-separated list of the OID integer arc values.
For example, consider the following declaration:
oid OBJECT IDENTIFIER ::= { ccitt b(5) 10 }
Thiswould result in the following definition in the Go source file:

var AsnlvOd [Juint64 = [Juint64{ 0, 5, 10 }
}
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Constructed Type Values

Generation of Go variables or constants for constructed type value specificationsis not supported in this release.

Table Constraint Related Structures

The following sections describe changes to generated code that occur when the -tables or -table-unions option is
specified on the command-line or when Table Constraint Options are selected from the GUI. This option causes
additional code to be generated for items required to support table constraints as specified in the X.682 standard. This
includesthe generation of structures and classes for Information Object Classes, Information Objects, and Information
Object Sets as specified in the X.681 standard.

Most of the additional itemsthat are generated are read-only tablesfor use by the run-timefor datavalidation purposes.
However, generated structures for types that use table constraints are different than when table constraint code gener-
ation is not enabled. These differences will be pointed out.

For Go, the table constraint code generation model is roughly equivaent to C when the -table-unions option is used.
That is, the generated structures are very similar to what would be generated for CHOICE constructs.

Unions Table Constraint Model

The unions table constraint model originated from common patterns used in a series of ASN.1 specificationsin-usein
3rd Generation Partnership Project (3GPP) standards. These standards include Node Application Part B (NBAP) and
S1AP and X2AP protocols in 4G network (LTE) standards. This pattern is repeated in 5G standards such as NGAP.

Generated Go Type Definitions for Message Types

The standard message type used by many specifications that employ table constraints is usually a SEQUENCE type
with elementsthat use arelational table constraint that uses fixed-type and typefields. The general formisasfollows:

<Type> ::= SEQUENCE ({
<el enent 1> <C ass>. &fi xed-type-fiel d> ({<bject Set>}),
<el ement 2> <(C ass>. &fi xed-type-field> ({<Cbject Set>)){ @l enent 1}
<el enent 3> <Cl ass>. &type-fiel d> ({<Obj ect Set >)){ @l erment 1}

}

In this definition, <Cl ass> would be replaced with a reference to an Information Object Class, <f i xed- t ype-
fi el d>would be afixed-type field wtihin that class, and <t ype-fi el d> would be atype field within the class.
<(bj ect Set > would be a reference to an Information Object Set which would define all of the possibilities for
content within the message. The first element (<element1>) would be used as the index element in the object set
relation.

An example of this pattern from the SLAP LTE specification is as follows:
Initiati ngMessage ::= SEQUENCE ({

pr ocedur eCode S1AP- ELEMENTARY- PROCEDURE. &pr ocedur eCode
({ SLAP- ELEMENTARY- PROCEDURES} ) ,

criticality S1AP- ELEMENTARY- PROCEDURE. &criticality
({ SLAP- ELEMENTARY- PROCEDURES} { @r ocedur eCode} ),
val ue S1AP- ELEMENTARY- PROCEDURE. &l ni ti at i ngMessage

({ SLAP- ELEMENTARY- PROCEDURES} { @r ocedur eCode} )
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In this definition, pr ocedur eCode andcri ti cal i ty are defined to be enumerated fixed types, and val ue is
defined to be an open type field to hold variable content as defined in the object set definition.

The generated Go structure is similar to what is used to represent a CHOICE type. The structure consists of a choice
selector value (T) followed by an inner structure (U) containing pointersto all of the alternative types that can appear
inthefield. Thisisthe general form:

type <Type> struct ({
<el enent 1> <El enent 1Type>
<el enent 2> <El enent 2Type>

/**

* informati on object selector
*/

T uint 64

/**
* <Cbj ectSet> information objects
*/
U struct {
/**
* <el enent 1> : <obj ect 1- el enent 1-val ue>
* <el enent 2> : <obj ect 1- el enent 2-val ue>
*/
<obj ect 1- name> *<obj ect 1- el enent 3-t ype>

/**
* <el enent 1> : <obj ect 2- el enent 1-val ue>
* <el enent 2> : <obj ect 2- el enent 2-val ue>
*/

<obj ect 2- nane>; *<obj ect 2- el ement 3-type>

}

In this definition, the first two elements of the sequence would use the equivalent Go type as defined in the fixed-
type field in the information object. The open type field (element3) would be expanded into the union structure as
is shown. The T value would hold a sequential number which is generated to represent each of the choices in the
referenced information object set. The union struct then contains an entry for each of the possible types as defined in
the object set that can be used in the open type field. Comments are used to list the fixed-type fields corresponding
to each open type field.

An example of the code that is generated from the SIAP sample ASN.1 snippet above is as follows:

const (
S1APPDUDescr i pt i ons S1APELEMENTARYPROCEDURESUNDEFTAG = 0
S1APPDUDescr i pt i ons S1IAPELEMENTARYPROCEDURESHandover Prepar ati onTAG = 1
S1APPDUDescr i pt i ons SIAPELEMENTARYPROCEDURESHandover Resour ceAl | ocati onTAG = 2
S1APPDUDescr i pt i ons S1IAPELEMENTARYPROCEDURESPat hSwi t chRequest TAG = 3
etc..

)

type Initiati ngMessage struct ({
Pr ocedur eCode ui nt 64
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Criticality uint64
Val ue struct {
/**
* informati on object selector
*/
T uint 64

/**
* S1AP- ELEMENTARY- PROCEDURES i nf or mati on objects
*/
U struct {
/**
* procedur eCode: id-HandoverPreparation
* criticality: CriticalityReject
*/
/I T=1
Handover Pr epar ati on *Handover Requi r ed

/**
* procedur eCode: id-Handover ResourceAl | ocation
* criticality: CriticalityReject
*/

[l T=2

Handover Resour ceAl | ocati on *Handover Request

/**
* procedur eCode: id-PathSw t chRequest
* criticality: CriticalityReject
*/

/I T=23

Pat hSwi t chRequest *Pat hSwi t chRequest

etc..

}

Note that the long names generated for the TAG constants can be reduced by using the <alias> configuration element.

Generated Go Type Definitions for Information Element (IE) Types

In addition to message types, another common pattern in 3GPP specifications is protocol information element (IE)
types. The general form of these typesisalist of information elements as follows:

<Pr ot ocol | EsType> ::= <Protocol | E- Cont ai ner Type> { <Obj ect Set> }

<Pr ot ocol | E- Cont ai ner Type> { <C ass> : <CbjectSetParanr } ::=
SEQUENCE (Sl ZE (<si ze>)) OF <Protocol |l E-Fi el dType> {{Obj ect Set Par an} }

<Protocol | E-Fi el dType> { <C ass> : <Object Set Paranm> } ::= SEQUENCE ({
<el enent 1> <C ass>. &fi xed-type-fiel d> ({Obj ect Set Par an}),
<el enent 2> <C ass>. &fi xed-type-fiel d> ({Obj ect Set Par an}{ @l enent 1}),
<el enent 3> <Cl ass>. &Type-fi el d> ({bj ect Set Par an} { @| ement 1})
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There are afew different variations of this, but the overall patternissimilar in all cases. A parameterized typeisused
as a shorthand notation to pass an information object set into a container type. The container type holds a list of the
|E fields. The structure of an |E field type is similar to a message type: the first element is used as an index element
to the remaining elements. That is followed by one or more fixed type or variable type elements. In the case defined
above, only asingle fixed-type and variable type element is shown, but there may be more.

An example of this pattern from the SIAP LTE specification follows:

Handover Requi red ::= SEQUENCE {
protocol | Es Pr ot ocol | E- Cont ai ner { { Handover Requi redl Es} },

}

Prot ocol | E- Cont ai ner {S1AP-PROTOCOL-1ES : |EsSetParan} ::=
SEQUENCE (Sl ZE (0..maxProtocol I Es)) OF Protocol | E-Field {{I|EsSet Parant}

Protocol | E-Fi el d { SIAP- PROTOCOL- 1 ES : | EsSet Paran} ::= SEQUENCE {
id S1AP- PROTOCOL- | ES. & d ({! EsSet Parant),
criticality S1AP- PROTOCOL- | ES. &criticality ({I EsSet Param}{ @ d}),
val ue S1AP- PROTOCCOL- | ES. &Val ue ({!I EsSet Param}{ @ d})
}

In this case, standard parameterized type instantiation is used to create a type definition for the protocol |Es element.
Thisresults in the following element declaration in the HandoverRequired type:

Prot ocol I Es [] Handover Requi r edPr ot ocol | ESEl enent
The type for the protocol IE list element is created in much the same way as the main message type was above:

t ype Handover Requi r edPr ot ocol | ESEl enent struct {
Id uint64
Criticality uint64
Val ue struct {

/**
* informati on object selector
*/
T ui nt 64
/**
* Handover Requi redl Es i nfornmati on objects
*/
U struct {
/**
* id: id-MVE-UE-S1AP-ID
* criticality: CriticalityReject
* presence: PresenceMandatory
*/
[ T=1
Handover Requi r edl ES| dMVEUES1API D *ui nt 64
/**

* id: id-eNB-UE-S1AP-ID

* criticality: CriticalityReject
* presence: PresenceMandatory
*/
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[l T=2
Handover Requi r edl Es| dENBUES1API D *ui nt 64

}

In this case, the protocol IE id field and criticality are generated as usua using the fixed-type field type definitions.
The open type field once again resultsin the generation of aunion structure of all possible type fieldsthat can be used.

Note in this case the field names are automatically generated (HandoverRequiredlESldAMMEUESIAPID, etc.). The
reason for this was the use of inline information object definitions in the information object set as opposed to defined
object definitions. Thisis a sample from that set:

Handover Requi r edl Es S1AP- PROTOCOL- I ES :: = {
{ IDid-MVE-UE-SIAP-I D CRI TI CALI TY rej ect TYPE MVE- UE- S1AP-| D
{ 1D id-Handover Type CRITI CALI TY rej ect TYPE Handover Type

In this case, the nameisformed by combining the information object set name with the name of each key field within
the set.
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Chapter 7. Generated PER Functions

Generated PER Encode Functions

PER encode functions are generated when the -per (packed encoding rules), -aper (aligned packed encoding rules),
or -uper (unaligned packed encoding rules), switch is specified on the command line. For Go, -per and -aper have the
same meaning - aligned PER encoders will be generated. The -uper option is used to generate unaligned decoders.
There is no option to switch between aligned and unaligned at run-time as there is for some other languages. For the
remainder of this section, the acronym PER will be used to mean either aligned or unaligned PER.

For each ASN.1 production defined in the ASN.1 source file, a PER encode function is generated. This function will
convert a populated Go variable of the given type into a PER encoded ASN.1 message.

Generated Go Function Format and Calling Parameters

The primary interface to encode data in Go is through the use of the generated Marshal function. This function has
the same signature as that found in the Go encoding/asnl package:

func Marshal (val interface{}) ([]byte, error)

Theval argument holdsavalue of thetypeto be encoded. Note that the Marshal function only encodestypes determined
to be Protocol Data Unit (PDU) types. By default, a PDU type in a schema is a type not found to be referenced by
any other type. This behavior can be overridden by using the -pdu command-line option to explicitly select types as
PDU types.

The Marshal function returns the encoded message in memory as abyte dice. If any errors occur during encoding, the
error result is returned in the error return value. The encoded value byte slice will be nil in this case.

Example of Calling the Go Marshal Function

The following code snippet was derived from the golang/sample_per/employee sample program in the ASN1C dis-
tribution:

package main

i mport (
"enpl oyee/ asnlgen”
"encodi ng/ hex"
" et
"iolioutil™
" os"

)

func main() {
var pdu asnlgen. Personnel Record

/1 popul ate PDU type variable to be encoded
fill Name(&pdu. Nanme, "John", "P", "Smith")

pdu.Title = "Director™
pdu. Number = 51
pdu. DateOfFHire = "19710917"
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fill Nane(&pdu. NameOf Spouse, "Mary", "T", "Smith")
[/ fill first child record

var childl nfo asnlgen. Childl nformation

fill Name(&childlnfo.Nane, "Ralph", "T", "Smth")
childlnfo.DateOFBirth = "19571111"

pdu. Chi | dren = append( pdu. Chil dren, chil dlnfo)

/1 fill second child record
fill Nane(&chil dl nfo. Nane, "Susan", "B", "Jones")

childlnfo.DateOFBirth = "19590717"
pdu. Chi | dren = append( pdu. Chil dren, childlnfo)

/1 Marshal
encodedDat a, err := asnlgen. Marshal (pdu)
if err == nil {

fnt.Printf("Personnel Record encoded successful I y\n")
fnt.Printf("%\n", hex.Dunp(encodedDat a))
err = ioutil.WiteFile("nmessage.per”, encodedData, 0777)
} else {
fnt.Printf("Encoding failed: %\n", err)

}
How Marshal Works And Alternatives

TheMarshal function isthe most convenient way to encode, but taking alook at how it worksalso provides alternatives,
should you want them.

First, well look at the other PER encode functions that are generated. There are two general forms:

func Per Encode<t ype nane>(pctxt *asnlrt. OSRTContext, value <go type>) (err error)

func (pval ue *<type nane>) PerEncode(pctxt *asnlrt.OSRTContext) (err error)
Here are two examples from the employee sample:

func Per EncodeEnpl oyeeNunber (pct xt *asnlrt. OSRTContext, value int64) (err error)
func (pval ue *Nane) Per Encode(pctxt *asnlrt.OSRTContext) (err error)
Thefirst form is used when the Go type for the ASN.1 typeisabuilt-in Go type - so basically it's used for the simple,
nonconstructed ASN.1 types. The second form is used when the Go type is a generated type.
Now we can look at the Marshal function to see what it does and how these functions are used:

/1 Create context object to manage encodi ng
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pctxt := newasnlrt. OSRTCont ext)
pct xt. | nit Encode() /1 Initialize for encodi ng
pct xt . NewBi t Fi el dLi st () /1l Optional: enable bit tracing

err = v.PerEncode(pct xt) /1 1nvoke the encode function; v is a generated type

pct xt . Fl ushBuffer ()
pctxt. PrintBitFieldList("pdu") /1 Optional: print bit trace

return pctxt.BufferData(), err /1 access the encoded data

Generated PER Decode Functions

PER decode functions are generated when the -per (packed encoding rules), -aper (aligned packed encoding rules),
or -uper (unaligned packed encoding rules), switch is specified on the command line. For Go, -per and -aper have the
same meaning - aligned PER decoders will be generated. The -uper option is used to generate unaligned encoders.
There is no option to switch between aligned and unaligned at run-time as there is for some other languages. For the
remainder of this section, the acronym PER will be used to mean either aligned or unaligned PER.

For each ASN.1 production defined in the ASN.1 source file, a PER decode function is generated. This function
decodes an encoded ASN.1 message contained in amessage buffer (byte slice) and storesthe resultsin adatavariable
of aGo type corresponding to the ASN.1 production type.

Generated Go Function Format and Calling Parameters

The primary interface to decode datain Go is through the use of the generated Unmarshal function. This function has
the same signature as that found in the Go encoding/asnl package:

func Unmarshal (b []byte, val interface{}) (rest []byte, err error)

The b argument is used to pass a byte slice into the function containing the message to be decoded. The val argument
holds apointer to avariable of thetypeinto which the message isto be decoded. Note that the Unmarshal function only
supports decoding of types determined to be Protocol Data Unit (PDU) types. By default, aPDU typein aschemaisa
type not found to be referenced by any other type. This behavior can be overridden by using the -pdu command-line
option to explicitly select types as PDU types>

The Unmarshal function returns any unused bytes after the message is decoded in the rest argument. This makes it
possible to decode a buffer containing multiple messages by looping to decode a message and then assigning the rest
result to the message buffer. When the buffer is empty, decoding would be terminated. If any errors occur during
decoding, the error result is returned in the err error return value.

Example of Calling the Go Unmarshal Function

The following code snippet was derived from the golang/sample_per/employee sample program in the ASN1C dis-
tribution:

package main

i mport (
"enpl oyee/ asnlgen”
"encodi ng/ hex"
Ilf m n
"iolioutil"
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)

0s

func main() {
var pdu asnlgen. Personnel Record

encodi ng, err :=ioutil.ReadFil e("message. per")
if err I'=nil {
fnt.Printf("Read nessage.per failed: %\n", err)
return
}

, err = asnlgen. Unmar shal (encodi ng, &pdu)

if err == nil {
fnt.Printf("Decoding was successful :\n")
} else {

fnt.Printf("Decoding failed: %\n", err)
}

How Unmarshal Works And Alternatives

The Unmarshal function is the most convenient way to decode, but taking alook at how it works also provides alter-
natives, should you want them.

First, well look at the other PER decode functions that are generated. There are two general forms:

func PerDecode<type nane>(pctxt *asnlrt.OSRTContext) (value <go type>, err error

func (pval ue *<type nane>) PerDecode(pctxt *asnlrt.OSRTContext) (err error)
Here are two examples from the employee sample:

func Per DecodeEnpl oyeeNunber (pct xt *asnlrt. OSRTContext) (value int64, err error)

func (pval ue *Nane) PerDecode(pctxt *asnlrt.OSRTContext) (err error)

Thefirst form is used when the Go type for the ASN.1 typeisabuilt-in Go type - so basically it's used for the simple,
nonconstructed ASN.1 types. The second form is used when the Go type is a generated type.

Now we can look at the Unmarshal function to see what it does and how these functions are used:

/1l Create context object to manage encodi ng

pctxt := newasnlrt. OSRTCont ext)

pct xt . I ni t DecodeByt es( b) /1 Initialize for decoding; b holds the encoded data
pct xt . NewBi t Fi el dLi st () /1 Optional: enable bit tracing

err = v. PerDecode(pct xt) /1 1nvoke the decode function; v is a generated type

pctxt. Ali gnBuffer() /1 Optional: prepare to decode a second nessage
pctxt.PrintBitFieldList("pdu") /1l Optional: print bit trace
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PER Bit Tracing

To print out a bit trace using ASN1C, invoke the appropriate functions after encoding or decoding a message and a
marked-up binary dump of the PER encoded data is produced.

To enable hit tracing logic to be embedded in the generated code, the -trace option needs to be specified on the
ASN1C command-line. If using the GUI, the Add tracing diagnostic messages to code box must be checked under

the 'Constraints and Debugging' tab.
If enabled, adisplay similar to the following will be printed out from within the Marshal or Unmarshal function:

Dump of decoded bit fields:
employee childrenPresent
IXXXXXXX 80 -

employee.name.givenName length
-------- 00000100 -------- -==-=-=-  =-04----  -.--

employee.name.givenName data
---------------- 01001010 01101111 ----4a6f --Jo

01101000 01101110 ----=-== =====-== 686e---- hn--

Here, adescription can be seen of the field that was decoded, followed by 4 columns of abase 2 representation of the
relevant input data, followed by a column with a hexadecimal representation of the same data, followed by a column
with an ASCII representation of the same data. The hexadecimal and ASCII representations are only printed after all
bitsfor afull byte have been processed, so these representations might not be printed on every line, and when they are
printed, might correspond to binary bits on several preceeding lines.

The x valuesindicate padding bits used in aligned PER.
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The Go language contains built-in support for Marshaling/Unmarshaling data to and from JSON format. However,
the default representation of the datais not always compliant with the JSON encoding rules (JER) as defined in ITU-
T X.697.

Go provides mechanismsto customize the default marshalling behavior so that alternate JSON formats, including JER,
can be supported. Thisis done through two code alterations:

* Setting custom JSON attributes
* Creating custom JSON Marshal/Unmarshal functions for specific types.

The following sections describe what is done in each of these areas and also general procedures for encoding and
decoding JSON data.

Custom JSON Attributes

Custom JSON attributes are mainly used to ater the marshaling and unmarshaling of elements within a SEQUENCE
or SET. They alow the following alterations to be performed:

» Change element name. This allows the ASN.1 name to be substituted for the Go element name.
* Omit empty items from the encoding (omitempty). This allows optional elements to be omitted.

» Remove elements (-). This allows elements to be removed that cannot be represented in JER (for example, an
unknown extension).

Custom JSON Marshal/lUnmarshal Functions

Custom JSON marshal and unmarshal functions are used to alter the encoded content for certain types. For example,
the content of a BIT STRING is JER does not match what would be encoded by default. The JER encoding has a
'length’ and 'value' member. A cusomized Marshal and Unmarshal method are therefore generated in the run-time to
modify the encoded value to be in the JER format.

Invoking JSON Marshal/Unmarshal Functions

JSON marshal and unmarshal functions are invoked using the standard Go JSON calling conventions defined in en-
coding/json. For Marshal the format is:

func Marshal (v interface{}) ([]byte, error)

where v is the value to be encoded. The encode result is returned as a byte dlice.
For Unmarshal, the format is:

func Unmarshal (data []byte, v interface{}) error

where datais abyte buffer containing the encoded JSON datato be unmarshaled (decoded) and v isthe target variable
into which the decoded data will be stored.
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Generated Print Functions

The following options are available for generating code to print the contents of variables of generated types:

-print - Thisisthe standard print option that causes print functions to be generated that output data to the standard
output device (stdout).

-genPrtToStr - This option causes print functions to be generated that write their output to a string variable.

Print to Standard Output

The -print option causes functionsto be generated that print the contents of variables of generated typesto the standard
output device. In this case, a function named Print is generated in the Marshal .go file with the following signature:

func Print(val interface{})

Theval argument holds avalue of thetypeto be printed. Note that the Print function only printstypes determined to be
Protocol Data Unit (PDU) types. By default, aPDU typein aschemais atype not found to be referenced by any other
type. This behavior can be overridden by using the -pdu command-line option to explicitly select types as PDU types.

Print to String

The -prttostr option causes functions to be generated that print the contents of variables of generated typesto a string
variable. In this case, afunction named PrintToSring is generated in the Marshal .go file with the following signature:

func PrintToString(val interface{}) string

Theval argument holds avalue of the typeto be printed. Aswas the case for the Print function, only variables of PDU
types may be passed to the function for printing.
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ASNI1C allows productions to be shared between different modules through the ASN.1 IMPORT/EXPORT mecha-
nism. The compiler parses but ignores the EXPORTS declaration within amodule. Asfar asit is concerned, any type
defined within amoduleis available for import by another module.

When ASN1C sees an IMPORT statement, it first checks its list of loaded modules to see if the module has aready
been loaded into memory. If not, it will attempt to find and parse another source file containing the module. Thelogic
for locating the sourcefile is as follows:

1. The configuration file (if specified) is checked for a <sourceFile> element containing the name of the source file
for the module.

2. If thiselement is not present, the compiler looks for afile with the name <M oduleName>.asn where module name
is the name of the module specified in the IMPORT statement.

In both cases, the —| command line option can be used to tell the compiler where to ook for the files.

To avoid having ASN1C search for additional source files, simply provide the definition of each imported module
in one of the source files specified as input to ASN1C. The imported module may be defined in its own source file,
or multiple module definitions can be located in a single source file. Here is an example of combining modules into
asingle sourcefile:

Modul eA DEFI NI TIONS ::= BEG N
| MPORTS B From Mbdul eB;

A::=B

END

Modul eB DEFINI TIONS ::= BEG N
B ::= | NTEGER

END

This entire fragment of code would be present in asingle ASN.1 sourcefile.
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